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INTRODUCTION

Congratulations on purchasing ECTACO Partner® EA B-3! You are now the owner
of the versatile, handheld electronic device which will serve you as a
comprehensive dictionary, personal organizer, and a music player.

ECTACO Partner® EA B-3 features:

o,

«+ English-Arabic bidirectional dictionary containing over 490,000 words,
including idioms, medical, technical, legal, and business terms, as well as
slang and general expressions

Voice function in English and Arabic
Phonetic Transcription
Spell-checker

Look-up function

User Dictionary

Bilingual interface

English Grammar guide

Most popular English idioms
English irregular verbs

Flash Cards

Word game

Instant Reverse Translation

Over 1,100 useful phrases in the English <*Arabic phrasebook
Currency and metric converters
Local and World time with a map
Address Book

ToDo Book

Date Book with audio reminders
Memo Book

Music Player

Calculator

Voice Memo

High-speed data exchange and synchronization with PC
Password protection

» Slang Lock
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.

++ High resolution touch screen
% MMC slot

«+ USB port

» Headphone jack

This model features a break-through combination of two input methods — a well-
designed on-screen keyboard and a high-resolution touch-sensitive handwriting
area which makes character input simple, fast and accurate.

D

e

o

o

D

*

+ Note: As continuous efforts are made by the manufacturer to ensure better
quality and performance of the product, some characteristics or the design of the
actual device you purchased may slightly differ from those described in this
manual.
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GETTING STARTED

General View

The general view and external appliances of ECTACO Partner® EA B-3 are shown
below.
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ECTACO Partner® EA B-3 features a larg
windows-driven graphic interface.

o Press the On/Off button to turn the device on.

If the screen remains blank, please make sure that the battery is inserted.

¢ To turn the device off, press the On/Off button once again.

o When the device is on, press and hold the On/Off button for approximately two
seconds to turn on the backlight. Press and hold the On/Off button once again to
turn the backlight off.

¢ |In most windows or dialog boxes, tap OK or Done to accept changes or Cancel
to exit without saving any changes.
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Headphone
Jjack

Speaker

Control
wheel

Reset

MMC slot button

Battery
compartment

Tap the screen with the supplied pointing device called the stylus which, when not
in use, is conveniently kept in a special slot at the side of the device’s back panel.
+ Note: If, for some reason, using the stylus does not provide the desired effect,
you may need to recalibrate the screen (see Launcher Menu on page 13).
ECTACO Partner® EA B-3 comes with a hard plastic cover to protect the screen
when the device is not in use. To attach the cover, insert the pegs on the cover into
the holes on either side of the device. To detach the cover, gently snap the pegs
out of the holes. We recommend that you keep the cover attached when you are
not using your ECTACO Partner® EA B-3.

Power Supply

ECTACO Partner® EA B-3 is powered by two AAA (LRO3) batteries. If the battery
power runs too low, the unit will start up when you press the On/Off button but will
then shut off automatically. When this happens, please replace the batteries
immediately to avoid the risk of losing user data.

+ Note: Make sure the battery is inserted in the battery compartment before
connecting your device to a PC.
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How to replace the batteries
o Press the On/Off button to turn the device off.
o Make sure the device is not on a hard surface — if the On/Off button is pressed
accidentally, user data may be lost.
+ Note: To avoid data loss, never try to remove the batteries from the device
when the power is on. If you experience difficulties turning the device off, press
the RESET button on the back of the device and restart the system.
¢ Remove the battery compartment cover by sliding it away from the device.
o Remove the used batteries and replace them with new ones.
+ Note: Do not mix old and new batteries.
o Make sure to place the batteries according to the polarity marks (+ -) inside the
battery compartment.
o Put back the battery compartment cover by sliding it toward the device. Make
sure the cover sits in place properly.

+ Note: You have one minute to replace the batteries without risk of losing the
data stored in RAM. Do not exceed the one-minute limit! Neither the
manufacturer nor the dealer may be held responsible for the loss of user data.

MultiMedia Card

ECTACO Partner® EA B-3 MultiMedia Card is included in the standard package.
The card contains the operating system and a set of applications. Please insert
ECTACO Partner® EA B-3 MultiMedia Card into the MMC slot before you turn the
device on.

+ Note: Always make sure the device is turned off before installing or removing
the MMC. Use the On/Off button to turn the device off.

Installing MMC

e Put your thumb on the MMC slot cover and slide it off.
MMC
slot

o Slide the MMC into the compartment with the contacts face up and the label
face down. Push the card gently until it clicks into place.
10
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e Snap the cover back on and then turn on the device.

The operating system and program files will be installed on your ECTACO Partner®
EA B-3. This will take about 2 minutes.

o To perform screen calibration, tap the center of the target with the stylus.
Repeat the process with three more targets, which will appear one after another.
Removing MMC

o To remove the MMC, first turn the device off. Push the card in slightly. You will
hear a click and the card will pop out.

Soft Reset

Occasionally, ECTACO Partner® EA B-3 may need to be reset to clear its memory.
In most cases, a soft reset is sufficient. The soft reset does not affect user data.

o Tap €3 to go to the Main Menu.

e Tap to open the Launcher Menu.

o Tap Restart system on the Launcher Menu.

¢ In the Ready for Restart screen, tap Restart now.

If the Launcher Menu is not accessible, use the blunt end of a paperclip to gently
press the RESET button located on the back of the device. Never use a needle or
a sharp pin for this purpose since it can damage the device.

Hard Reset

In the rare event that the data on the screen is corrupted, a program is not
responding properly, or you forgot your password, you will need to perform a hard
reset. After a hard reset all user data will be lost. Synchronize your data often so
that you always have a copy on your PC.

e To perform the hard reset, keep the On/Off button pressed while pressing the
RESET button.

Control Pad

The Control Pad is the area below the touch-sensitive screen where you can tap
icons, write characters, or use the scroll area to control your ECTACO Partner® EA
B-3.

11
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Handwriting area

Launcher icon N

\ @ Scroll area
<((‘:w))>
=) | 123 é
Menu icon
Control Pad Elements and Their Functions
Launcher icon Switch to the Main Menu.
Menu icon Show the available menus. Menus shortcuts, where
available, are shown to the right of the menu items.
Handwriting area Write letters in the Letter input area "abc", punctuation
in the Punctuation input area ":-)", and numbers in the
Number input area "123".
Scroll area Scroll the screen content.
Main Menu

o Tap €3 to go to the Main Menu.

ECTACO Partner® EA B-3 Main Menu contains a row of three tabs at the bottom of
the screen and the universal indicator. The tabs are named as follows: Dictionary,
Organizer, and Extras.

Dictionary

¢ Use the Dictionary tab to access the following applications: Dictionary, English
Idioms, Flash Cards, Hangman, Irregular Verbs, and Phrasebook.

Organizer

o Use the Organizer tab to access the following applications: Address Book,
Calculator, Currency Conversion, Date Book, Memo Book, Metric Conversion,
Music Player, ToDo Book, and Voice Memo.

Extras

¢ Use the Extras tab to access the following applications: Setup, English
Grammar, Local Time, and World Time.

Universal Indicator

This is a graphic item located in the lower right corner of the Main Menu. By
default, it shows the current time.

12
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o Tap the universal indicator a few times to successively display the current date,
percent of remaining battery power, battery power graphic, and the amount of
available memory in the device.

Launcher Menu
o When in the Main Menu, tap to invoke the Launcher Menu.

Handwriting Guide
Restart system
Fen calibration
set contrast
bizable Passwaord
MRC Backup
Launcher Help
Active Frograms
File Manager
About

+ Note: To perform the MMC Backup operation, please use a re-writable MMC
(64 MB or above).

Natural Handwriting

Entering data with natural handwriting takes some practice. Please follow the steps
below to enter a sentence in the Memo Book.

o From the Main Menu, tap an icon for a program allowing data entry. For
example, Memo Book.

e Locate a field for data entry. For example, tap New to go to the Edit screen.

A blinking cursor appears in all fields where data can be entered. If the blinking
cursor does not appear, the field is not active.

¢ Place the pointed end of the stylus at the center of the Letter input area and
draw a line straight up to write the following letter in uppercase (Shift mode).

A single dot appears in the cursor to indicate shift.

« In the center of the Letter input area, write the letter "a". Start the stroke where
indicated by the point and draw it as it appears in the Handwriting Guide. Write the
characters left to right.

o Take the stylus off the screen, and the character will appear in the data entry
field.

Natural handwriting also recognizes simple strokes for Backspace, Return and
Space, as well as Shift and Cap Lock.

+ Note: Always write in lowercase, as shown in the Handwriting Guide. If you
want to enter letters in uppercase, first write the stroke for Shift or Caps Lock.

¢ To enter a space, place the pointed end of the stylus in the center or left side of
the Letter input area and draw a horizontal straight line to the right.

13
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If the character is composed of more than one stroke, you may see interim results
on the screen. For example, when you write "k," an "I" may show on the screen
before the "k" appears.

+ Note: If a character is not recognized, you will hear a beep.

Please follow these guidelines when entering punctuation marks:

Period and  Write in the lower part of the appropriate input area.
Comma

Apostrophe  Write in the upper part of the appropriate input area.

Simple strokes make it easy to write functions, such as Backspace, Space, Shift,
and Caps Lock.

Stroke  Function
Delete the previous character (Backspace).
Insert a space.

Insert a line break (Enter).

Write the next letter in uppercase (Shift).

—LI1

Switch to uppercase (Caps Lock). When it is necessary to return
to lowercase, draw the Shift key symbol, as shown above.

Handwriting Guide

o From the Main Menu, tap and then select Handwriting Guide.

o Tap the arrows [IL [ to scroll through each screen of the Handwriting Guide.
+ Note: Before you input accented characters, please make sure you have
selected the appropriate Pen Language (see page 16).

Control Wheel

e Turn or push the control wheel to select or open an item, where available.
o Turn the control wheel to scroll one page when reading.

+ Note: The control wheel turns up and down; it does not spin. Please do not put
excessive force on the control wheel.

o Turn the control wheel to control the volume when listening to music.

Opening and Closing Programs
o Toopen a program, tap its corresponding icon.

14
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o To return to the Main Menu without closing the program, tap e .To

immediately return to the program, tap “= once again.
e To exit a program, tap in the top right corner, or use the File / Exit command.
On-screen Keyboard

The on-screen keyboard supports all the English and Arabic letters, as well as
numerals and punctuation marks.

o To invoke the on-screen keyboard, draw a line straight up outside the

Handwriting area or tap E, where available.
The basic layout contains letters of the respective alphabet and a set of symbols.

e Tap or to switch to the Arabic or English layout respectively.
+ Note: For some applications, the English keyboard layout is only available.
o Tap ENTER to save your text and hide the on-screen keyboard.

SETUP

The Setup application allows you to fine-tune the device interface.

o Tap the Setup icon from the Extras tab to launch the application.
Interface Language

The default interface language of ECTACO Partner® EA B-3 is English.
e Tap V¥ next to Interface and select English or Arabic.

The device will reboot and then all the messages and menus will appear in the
chosen language.

Select Date

e Tap anywhere on the date field to change the date or view another date.
Select Time

o Tap the up and down arrows to change the hour and minute.

o When 12-hour format is set, tap AM or PM to toggle between AM and PM.
Volume

¢ Toincrease or decrease the volume, move the slider to the right or left.
Password

A password can be set up in the system to protect your personal records and lock
up the PC communication function.

15
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Setting the Password
e Tap =] o open the Enter password screen.
o Specify a password up to 8 characters in length. Tap OK.
o Retype the password for confirmation. Tap OK.

Changing or Clearing the Password

o Tap E= 1o open the Enter password screen.
o Input the current password. Tap OK.
o Specify a new one. When clearing the password, leave the filed blank. Tap OK.
¢ Retype the new password for confirmation. Tap OK.

+ Note: Always remember your password. If you forget it, you will have to reset
the system, which may cause irrevocable loss of user data.

Disabling or Enabling the Password
¢ Go to the Main Menu, tap and then select Disable Password.

e To re-enable the password, tap and then select Enable Password.

Sounds

o Select the Quiet Mode check box to turn the device sounds off.

+ Note: Music files, and the Date Book alarm are not affected by this option.
Pen Language

Allows you to activate character recognition for several languages. Select Western
European (W. European) to access all the supported characters.

Shutoff Time

Allows you to set the time that elapses before the device automatically turns off.

¢ To change the shutoff time, tap ¥ and then select 1, 2, or 5 minutes.

Time Format

By default, the time format is HH:MM AM/PM, where HH is the hour and MM is the
minute. To change the time format, tap ¥ and select the desired format.

Date Format

By default, the date format is MM/DD/YY, where MM is the month, DD is the date,
and YY is the year. To change the date format, tap ¥ and select the desired
format.

16
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Numbers

By default, the number format is 1,000.00. To change the number format, tap ¥
and select the desired format.

Week Start

By default, the start of the week is Sunday. To change it, tap ¥ and select
Monday.

Double-click

Allows you to set the speed at which the screen recognizes taps from the stylus. By
default, the setting is Fast. To change the speed, tap ¥ and select the desired
speed.

e Tap Done to save your changes.

APPLICATIONS

Touch buttons

Button(s) Function(s)

Invoke the on-screen keyboard

Check spelling of the word typed on the input line
Open the User Dictionary

Change the font size (three font sizes available)
Change the direction of translation

Hide / unhide slang words and phrases in the dictionary. The default
password is showslan.

Add the highlighted entry to a set of flash cards

Obtain a reverse translation of the selected word or phrase

Go to the previous or next entry respectively

Pronounce a headword or a highlighted portion of translation

Voice function is not available for the selected item

Open a new record template; start a new game (in Hangman)

Save a record

Delete a record

Change the difficulty level in Hangman

Show the translation of the hidden word in Hangman (counts as a try)

17
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g«»%'_.ﬂ Create a new set (in Flash Cards)

j;c Rename the selected set (in Flash Cards)

&l Reset statistics for the currently viewed set (in Flash Cards)

£ Open the Edit set or Set setup screen (in Flash Cards)

':j Display the List of sets (in Flash Cards)

%iﬂ Create a set of 50 randomly chosen entries (in Flash Cards)
Lookup

o Enter a word either from the Handwriting area or from the on-screen keyboard,
or just select it from the word list using the stylus or control wheel.

o Use the available touch buttons (see above).
o To listen to the pronunciation of the selected entry/word or its translation, tap on

the respective area and then tap 'E'

Dictionary

The Dictionary application includes English-Arabic and Arabic-English dictionaries
with a total of 490,000 words.

Spell-checker Vector Ultima™

Vector Ultima™ allows you to enter the word as you hear it and choose a spelling
version from a list of suggestions.

o Type the word "board" as you hear it: "bord".
! .
e Tap 4 to open the Variants list.
e Tap the desired variant to look up its translation(s).
Pronunciation of Words and Phrases

The voice function is available for all English entries in the Dictionary and for a
certain number of Arabic entries. To use the voice function:

e Tap "E’ or press the control wheel to listen to the pronunciation of the
headword, if available.

o Highlight the translation(s) and then tap "E’ to listen to its pronunciation.
Changing Font Size

e Tap AR 6 reduce or enlarge the font size.
Instant Reverse Translation
« Highlight the desired word or phrase by using the stylus.

L=
o Tap EE to make the reverse translation. (Five reverse translations available.)

18
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User Dictionary
The User Dictionary automatically links to the main dictionary.

o Set the desired direction of translation and then tap 3

e Ifthere is already an entry present in the User Dictionary, tap [B to open a new
record template.

¢ Type the headword, specify its part of speech and then type the translation.

e Tap @ to save your record or X to delete it.

o Use &, ¥ 0 go to the previous or next entry respectively.
Adding Entries to Flash Cards

e Toadd an entry to a set of Flash Cards, tap E‘ and then select the desired set.
o To make a set the default location to add entries, just select it and then tap the
Set current button.
+ Note: The Dictionary and Flash Cards applications use the same database.
When both applications are running simultaneously, the Object is in use message
may appear at certain operations. However, this is normal. Just close either of the
applications by tapping )

Abbreviations
Translations of a headword are listed in alphabetical order of parts of speech. A -
adjective, ABBR - abbreviation, ADV — adverb, ART - article, AUX — auxiliary,
CONJ - conjunction, ID —idiom, INTRJ - interjection, N — noun, NPR — proper
noun, NUM — numeral, PART - particle, PHR — phrase, PREF - prefix, PREP —
preposition, PRON — pronoun, SUFF — suffix, V — verb.
Slang words and expressions in the dictionary are marked with the [SL.]
abbreviation. These are not shown when the Slang Lock function is enabled.

English Idioms

In the English Idioms application, you can find over 200 widely used idioms with
their equivalents or translations. The voice function is available for all entries in this
application.

Flash Cards
This fascinating program will help you enlarge your vocabulary quickly and
advance considerably in learning a foreign language.
¢ In the beginning, please select the desired language by tapping S and then
tap Eji.
You will see the Set setup screen.

19
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o Tap g%;ﬂ to create a new set.

+ Note: You can create up to 100 sets.

By default, the first set is named my set 1 (eng,0). A number in the non-editable
part of set name (in parentheses) indicates how many entries are currently stored
in the set. The eng label is assigned to the sets containing English headwords
while the ara label is intended to mark out the Arabic sets.

e Once you have created your set(s), tap % to close the Set setup screen and
return the Edit set screen.

o Choose the desired set by tapping ¥ in the upper part of the screen, next to
Current set.

o To fill the desired set with words from the Dictionary, highlight the desired entry

and then tap E‘
+ Note: You can store up to 50 flash cards in a set.

o Use %iﬂ to create a set of 50 randomly chosen entries.

When you have filled the desired set, you are ready to start learning.

o Tap {) to close the Edit set screen. The Flash Cards screen will be shown.
o Use the available touch buttons (see page 17).

The number of unlearned cards in a set is recorded for each game. This
information is displayed on the screen. For example, Left: 10 means you have 10
cards unlearned.

e Tap the Drop button to set a card apart.

e To go to the next card, tap Next >>.

o Select the Always show translation option to have the program show you
translation in each card.

o Alternatively, tap on the Show Translation message to see the translation. To
hide the translation, just tap on it.

A
e Tap ':-_'I to display the List of sets. Finished sets will be marked out in this list.
Your goal is to learn all cards in your set. You may quit the game and resume

playing at any time. Just launch Flash Cards to start playing beginning from where
you left.

Hangman Word Game

ECTACO Partner® EA B-3 features the learning game Hangman, which improves
your spelling skills and enhances your personal vocabulary.

o Enter letters from the displayed touchpad, trying to guess the hidden word.
The number next to Attempts left shows the remaining number of tries.

20
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Irregular Verbs

All commonly used English irregular verbs are stored in the Irregular Verbs
application. The voice function is available for all entries in this application.
Phrasebook

The Phrasebook contains over 1,100 phrases in the English and Arabic languages.
The phrases are divided into 12 conversational topics. The voice function is
available for all entries in this application.

o To open the selected topic, tap it with the stylus or just push the control wheel.

Address Book

Your ECTACO Partner® EA B-3 includes Address Book, a standard organizer
program for storing names, telephone numbers, street and electronic addresses.

Creating a Record

e Tap New.
o Tap in the data entry column next to the desired label.

e To see additional labels, tap the button for the desired view and then tap in the
data entry column next to the desired label. Tap ¥ to see the drop-down list and
select the name you want. Enter your information in every view and field you want.

¢ In the Personal view, tap Details to select the phone number you want
displayed.
Editing Entries
o 1) Tap the desired entry and then tap in the data field you want to change.
o Enter or edit information in any view and field.
e Tap Done or {#! to save your changes and return to the Contacts List.
e 2) Or, hold your stylus down on the entry.
o Select Edit on the appeared menu.
Custom Fields

e From the Contacts List, tap and then select File / Custom Fields.
o Tap in the field of the label you want to edit and specify the desired label name.
o Use File / Preferences to set the desired sort order.

Searching for an Entry

o When in the Contacts List, tap on the line next to Search and enter the first letter
or letters of the entry you want to find.

Deleting Entries
« In the Contacts List, hold your stylus down on the entry you want to delete.
21
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o Tap Delete on the appeared pop-up menu.
Menus

The File menu is available in the Contacts List and the Edit menu is available in
each of the four views when the cursor is blinking.

o When the program is running, tap to display the available menus.

Calculator

ECTACO Partner® EA B-3 includes a standard calculator with 10-digit display

capacity.

o Use this program as a standard pocket calculator.

Currency Conversion

Allows you to instantly calculate cross rates for combinations of over 25 currencies.
Setting and Checking Rates

o Tap on the currency name to open the Currency setup window.

o Change/specify the Currency name and/or Currency rate. Tap Save.

o To add user-defined currencies to the list, tap [jj . The Currency setup window

will open. Enter the desired data into the Currency name and Currency rate fields.

Conversion
o Set the cursor position to the desired field in the right column of the table.
e Enter the value. The conversion is performed while you are typing.

Date Book
A standard organizer program for scheduling.
Adding Appointments
e Tap Go To, select the desired month and day and then tap Select.
+ Note: You must be in the Daily View to add appointments to your schedule.
o Tap on the desired line in the data entry column and enter your appointment.
o Tap the time approximate slot for your appointment to set a start and end time.

e In the Edit window, tap to display the Recurrence screen.
o Tap the check box next to Daily, Monthly, Weekly, or Yearly.
e Tapabutton (SMTWTF S) to set the day of the week for the recurring event.

¢ |n the Edit window, use to set the time when the alarm will sound.

22
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Views
The Daily View displays the schedule for the selected day. It is the first screen you

see when you enter Date Book. To return to this view from another screen, tap .
o Use @ to return to the current date.

The Weekly View displays the schedule for a single week. Tap \= to go to the
Weekly View.

e Tap @ at the bottom of the screen to see the week’s schedule as a list.
e Tap =l at the bottom of the screen to see the week’s schedule as a grid.

e The Monthly View displays the schedule for any single month. Just tap .
Menus

There are two menus in Date Book: File and Edit. The File menu is available in the
Weekly and Monthly Views and both menus are available in the Daily View.

o When the program is running, tap to display the available menus.

Memo Book
The Memo Book application provides you with a storage place for your notes.
e To add a memo, tap New and enter your memo. Tap Done to save it.
e Tap V¥ to see the Sort drop-down list.
e To view the whole memo, tap the number of the desired memo.
Editing Memos
o Tap the memo you want to edit.
o Place the cursor where you want to edit and then add or delete text. Tap Done.
Menus

There are two menus in Memo Book: File and Edit. The File menu is available in
the memo list and both menus are available in the Edit screen.

o When the program is running, tap to display the available menus.

Metric Conversion

With ECTACO Partner® EA B-3 you may easily convert units of measure.

e Choose a subsection by tapping ¥ in the upper left corner of the screen.
o Set focus to the desired field by tapping in it and then enter the value.
The conversion is being performed while you are typing.
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Music Player

ECTACO Partner® EA B-3 includes Music Player, a program allowing you to play
music. The program supports MP3 files.

¢ To download MP3 files into your device, please use Desktop Manager and a re-
writable MMC (64 MB or above).

+ Note: If the source MP3 file is in a wrong encoding, Music Player may not be
able to recognize it or even may stop responding. Use the Active Programs menu
to stop the program in this case.

Buttons
Q. Play, 0._ Pause playing, O — Stop playing, e — Fast forward, Q -
Rewind.

Menus

o When the program is running, tap to display the available menus.
ToDo Book

ToDo Book is a standard organizer program for managing your tasks.
Adding Entries

o Tap New and enter a todo text.

e Tap the Priority icon and select Low (&), Normal (#), or High ( !).

o Tap Edit to add settings.

e Tap on the completion check box to mark/unmark a todo as completed.
Editing Entries

o Place the cursor in a todo where you want to edit and make your changes

e To delete a todo, hold the stylus down on the task. On the appeared menu, tap
Delete.

Menus
There are two menus in ToDo Book: File and Edit. The File menu is available when
no todo is selected in the ToDo List. When a todo is selected, both menus are
available.

o When the program is running, tap to display the available menus.

Voice Memo
Voice Memo allows you to record memos and play them back.
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Buttons

0 — Record a memo. This button changes to Stop when you are recording or
listening. O — Stop the memo recording or playing. 0 - Play the memo. 0 -
Pause playing. e — Fast forward. - Rewind.

Menus
o When the program is running, tap to display the available menus.

English Grammar

ECTACO Partner® EA B-3 provides a well-structured English Grammar guide. The
Grammar is shown in English, regardless of the selected Interface language.

e To open an article, just tap on its title. Use <] to go up one level.
o Use the available touch buttons (see page 17).

Local Time

The Local Time application shows: the name of the city and country representing
the local time zone and a map of the corresponding continent, the current date, and
the current time.

e Tap EI to the left of the city or country name to open the list of cities or
counties respectively.

o To add a new city to the list, tap D to open the New city template.
o Use @ to hear the announcement of the displayed time.

o Use 2o tum Daylight Saving Time (DST) on or off.

World Time

Using ECTACO Partner® EA B-3, you may view current times in cities around the
globe, along with appropriate map illustrations.

e Tap EI to the left of the city or country name to open the list of cities or
counties respectively.

e Toadd a new city to the list, tap [jj to open the New city template.
o Use 'E' to hear the announcement of the displayed time.
o Use ﬂ to turn Daylight Saving Time (DST) on or off.
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PC COMMUNICATION

Using the USB cable and Desktop Manager software you may exchange data
between your ECTACO Partner® EA B-3 and a personal computer. This will allow
you to keep a backup copy of user data. When prompted to specify a path to the
device driver, go to the folder into which you have installed Desktop Manager, then
open the USB_Driver folder and select ebookman.sys. The default path is
C:\Program Files\aDawliah\Desktop Manager\USB_Driver.

Toolbar
The Desktop Manager toolbar buttons perform the following functions:

% - synchronize data between your PC and ECTACO Partner® EA B-3. :L] -
go to the upper folder. lﬁ —display files in the Contents folder. m — display
files from the Library folder in the Contents pane. — switch from the

Connection view to the Contents view. — switch from the Contents view to the

Connection view.

Views

In the Connection view, if Desktop Manager detects the device, the image on the
screen will show the connection.

The Contents view uses two list panes to organize and display files stored on your
PC (the Contents pane) and content stored in the device (the Device pane).

¢ Right-click on a file or folder to access its context menu.

Menus

File

Menu Item Function

Synchronize Synchronize all files between the current Contents
directory and the device.

Send to device Move a highlighted file from the Contents pane to the
Device pane.

Send to PC Move a highlighted file from the Device pane to the

Contents pane.
Copy to Library Folder  Copy a highlighted file to the Library folder.

Copy to Contents Copy a highlighted file to the Contents folder.
Folder
Unpack Expand a zipped seb file.
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Delete
Properties

Open
Change to Contents
Folder

Change to Library
Folder

Change Folder
Change Sync Folder

Exit
View
Menu Item

Device Info
Toolbar

Switch Panes
Refresh

Remove a highlighted file or folder.

Display the properties of the highlighted file: name, type,
size, publisher, and security.

Open a highlighted folder.

Change the directory in the Contents pane to the Contents
folder.

Change the directory in the Contents pane to the Library
folder.

Change the folder displayed in the Contents pane.

Change the folder from which content is synchronized to
the device.

Close Desktop Manager.

Function

Display information about the device.

Display or hide the toolbar. By default, the toolbar is
displayed.

Switch the Contents and Device panes.

Reload the active pane.

+ Note: Due to a difference in the file systems of ECTACO Partner® EA B-3 and
PC, file sizes shown in the Contents pane may slightly differ from those shown in

the Device pane.

27



ECTACO Partner® EA B-3 User Manual

INTERNATIONAL WARRANTY

ECTACO, Inc. (Ectaco) guarantees to the end user that this product will be free of defects in
material and craftsmanship for a period of ONE YEAR from the date of original retail
purchase, as evidenced by the sales receipt.

This warranty does not apply if any other party has damaged the product by accident, abuse,
and misuse, or as a result of service.

Except for the limited warranties above, this product is provided on an “as is” basis, without
any other warranties or conditions, expressed or implied, including but not limited to,
warranties of merchantable quality, merchantability or fitness for a particular purpose, or
those arising by law, statute, usage of trade, or course of dealing. Neither Ectaco nor its
dealers or suppliers shall have any liability for any indirect, incidental, special, or
consequential damages whatsoever, including but not limited to, loss of revenue or profit, lost
or damaged data or other commercial or economic loss, even if we have been advised of the
possibility of such damages, or they are otherwise foreseeable. We are also not responsible
for claims by a third party. Our maximum aggregate liability to you, and that of our dealers
and suppliers, shall not exceed the amount paid by you for the Ectaco product as evidenced
by your purchase receipt. If the laws of the relevant jurisdiction do not permit full waiver of
implied warranties, then the duration of implied warranties and conditions are limited to the
duration of the express warranty granted herein. This warranty applies only to the products
manufactured by Ectaco and does not include batteries etc. Any damages caused by
batteries are not covered by this warranty.

You may obtain additional information regarding the extended warranty program or reach a
customer service representative at the following telephone numbers or addresses:

North America

USA, New York Canada

Ectaco, Inc. Ectaco-Canada, Inc.
Ectaco Corporate Center, Tel.: +1-800-710-7920
31-21 31st Street E-mail: sales@ectaco.ca

Long Island City, NY, USA, 11106
Tel.: +1-718-728-6110
E-mail: sales@ectaco.com

Chicago

5700 W. Belmont Ave.,
Chicago, IL, 60634

Tel.: +1-773-202-0729
E-mail: chicago@ectaco.com
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Europe and Asia

Germany, Berlin
Ectaco Germany, GmbH.
Tel.: +49-30-8950-3535
E-mail:
germany@ectaco.com

Belarus, Minsk

Ectaco BEL

Tel.: +375-17-232-9701
E-mail: belarus@ectaco.com

Czech Republic, Prague
Ectaco-Czech, Ltd.

Tel.: +420-2-6126-3098
E-mail: ceska@ectaco.com

Azerbaijan, Baku
Ectaco-Azerbaijan, Ltd.
"REMCO"

Tel.: +994-12-974411
+994-12-971155
+994-12-974344

E-mail:

azerbaijan@ectaco.com

Hungary, Budapest
SKK Trade Kit.

Tel.: +36-1-264-3345
E-mail:
hungary@ectaco.com

United Kingdom, London
Ectaco (UK) Ltd.

Tel.: +44-207-936-9063
E-mail: uk@ectaco.com

Ukraine, Kiev
Ectaco-Ukraine, HPKP

Tel.: +380-44-516-5724
E-mail: ukraine@ectaco.com

Israel, Tel-Aviv
Ectaco-Israel 2000, Ltd.
E-mail: israel@ectaco.com

Greece, Athens
Ectaco-Greece, Ltd.

Tel.: +30-210-9635271
E-mail: greece@ectaco.com

Latvia, Riga
E-mail: latvia@ectaco.com

Visit us on the Internet at www.ectaco.com
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Poland, Warsaw
Ectaco-Poland, Sp. z 0.0.
Tel.: +48-22-844-1664
E-mail:
poland@ectaco.com

Russia

Ectaco-Russia, Ltd.

St. Petersburg

Tel.: +7-812-545-3838
E-mail: russia@ectaco.com
Moscow

Tel.: +7-095-737-8910
E-mail: moscow@ectaco.ru

China, Hong Kong
Ectaco Hong Kong, Ltd.
Tel.: +852-2331-9876
E-mail:
hongkong@ectaco.com
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Warranty Registration

In case of malfunction, please fill out this registration slip and send it with your
device to the nearest Ectaco service center. Make sure to include your telephone
number.

Name

Age

Telephone number
(required)
Address

Date and location of
purchase

Serial number
(required)

Description of defect(s)

Copy of sales receipt 0
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Tel.: +1-773-202-0729 31-21 31st Street
E-mail: chicago@ectaco.com Long Island City, NY, USA, 11106

Tel.: +1-718-728-6110
E-mail: sales@ectaco.com

Ectaco-Canada, Inc.
Tel.: +1-800-710-7920
E-mail: sales@ectaco.ca
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L g jf clail gy
Ectaco-Poland, Sp. z 0.0.
Tel.: +48-22-844-1664
E-mail: poland@ectaco.com

Ly
Ectaco-Russia, Ltd.

& sk Gl
Tel.: +7-812-545-3838
E-mail: russia@ectaco.com

Sga

Tel.: +7-095-737-8910
E-mail: moscow@ectaco.ru

LS Jgp (Guall
Ectaco Hong Kong, Ltd.
Tel.: +852-2331-9876
E-mail:
hongkong@ectaco.com

Al (Bastal) A<taal)
Ectaco (UK) Ltd.
Tel.: +44-207-936-9063
E-mail: uk@ectaco.com

s (L) S gl

Ectaco-Ukraine, HPKP
Tel.: +380-44-516-5724
E-mail:
ukraine@ectaco.com

a5 el )
Ectaco-Israel 2000, Ltd.
E-mail: israel@ectaco.com

Ectaco-Greece, Ltd.
Tel.: +30-210-9635271
E-mail: greece@ectaco.com

Uy (LY
E-mail: latvia@ectaco.com

Ll g Lig 15/

Sl cLilali
Ectaco Germany, GmbH.
Tel.: +49-30-8950-3535
E-mail: germany@ectaco.com

Adisa g sl
Ectaco BEL
Tel.: +375-17-232-9701
E-mail:
belarus@ectaco.com

§1os (LSadl 4 ggar
Ectaco-Czech, Ltd.
Tel.: +420-2-6126-3098
E-mail: ceska@ectaco.com

38k cglag 3
Ectaco-Azerbaijan, Ltd.
"REMCO"

Tel.: +994-12-974411
+994-12-971155
+994-12-974344

E-mail:

azerbaijan@ectaco.com

Conuglaga oy jlada
SKK Trade Kft.
Tel.: +36-1-264-3345
E-mail:
hungary@ectaco.com

www.ectaco.com b <A adga o Ugug)
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